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1. Labeling and symbols 

 

 

 

DentalEye 3.2 is a medical device, CE-marked according to the directive 

93/42/EEC.  

 

Manufacturer: 

DentalEye AB 

Kavallerivägen 30 

SE-174 58 SUNDBYBERG 

SWEDEN 

 

Tel: +46 (0)8-621 07 00 

Fax: +46 (0)8-621 07 55 

Email: info@dentaleye.com 

www.dentaleye.com 

 

The date of manufacture is shown in the software. 

 

Read all instructions before use! 

 

The catalog number is DentalEye 3.2.  

Current product version is shown in the software (DentalEye 3.2.x). 

This version of the installation instructions is valid for product versions 

from DentalEye 3.2.1. 

 

W A R N I N G !  

This symbol alerts the user to the risk of possible injury, death or other 

serious adverse reactions. 

 

C A U T I O N !  

Instructions with this symbol must be followed in order to ascertain proper 

function of the equipment.  

 

 

 

 

 

mailto:info@dentaleye.com
http://www.dentaleye.com/
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2. Important safety precautions 

  The product must be installed properly before put into clinical use - follow the instructions in the 

Installation instructions included with the product! 

  The product may only be used by authorized dental practitioners. 

  The product may only be used in accordance with its intended use. 

  Read the Instructions for use before using the product and follow all safety precautions! 

  Any incident or harm to a patient or operator that might be caused by the product must be 

reported to the manufacturer or distributor. 

3. Product description 

DentalEye 3.2 is a dental imaging software. Images can be directly acquired from X-ray sensors, 

phosphor plate scanners, panoramic X-ray devices, intraoral cameras and other imaging equipment from 

most common manufacturers in the dental field. Images can also be imported and exported as files or via 

DICOM transfer. Patient information is stored within the system or via integration with a patient 

management system. 

 

DentalEye includes support for DICOM (Digital Imaging and Communications in Medicine) which is a 

standard for transfer and storage of medical digital images. 

 

The system uses modules, called plugins, for communicating with imaging equipment such as X-ray 

sensors, scanners or cameras. 

 

The main functions in DentalEye 3.2 are: 

 

 Image acquisition via plugins or file import 

 Image enhancement, e.g. brightness/contrast adjustment 

 Patient information entry and storage 

 Arranging images into predefined templates 

 Storing images and patient information 

3.1. Product variants 

The product is available in two variants: DentalEye 3.2 Pro for dental practices without need for DICOM 

communication and DentalEye 3.2 Enterprise for hospitals and larger practices with a need for DICOM 

communication. Both variants handle DICOM files and store images in a common database, accessible 

from all computers via the network. The Enterprise variant can also store images on a DICOM storage 

server (PACS). 

 

The differences between the variants are listed in table 1. Most functionality accessible via the user 

interface is identical between the variants and these instructions for use describe both variants. 
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Table 1. Differences between the product variants 

 DentalEye Pro DentalEye Enterprise 

Patient search DentalEye database DentalEye database + DICOM database 

DICOM 

communication 

not included DICOM query/retrieve/store 

DICOM print 

Modality Worklist query 

File format internal storage: non-DICOM format 

document file import 

internal storage in DICOM format 

no support for document file import 

support for JPEG 2000 

Event log not included stored in database 

 

The software variant in use is controlled with a license key stored in the database of the system. License 

keys are issued in the name of the dental practice and allow use of a certain maximum number of 

computers.  

 

The license key is time-limited and subject to yearly renewal. If the subscription ends the software will 

revert to a restricted mode where no images or patient information can be shown. If the user has migrated 

to another software but wishes to access existing images in DentalEye, a time-limited viewer license can 

be issued. With a viewer license, images and patient information can be viewed and exported but image 

acquisition and import will be disabled. 

4. Regulatory information 

DentalEye 3.2 is a Class IIa medical device, CE-marked according to the directive 93/42/EEC. The 

product is in compliance with European standards according to table 2. 

 

Table 2. Compliance with European standards 

Standard Name 

EN ISO 13485:2012 Medical devices – Quality management systems – Requirements for regulatory 

purposes 

EN ISO 14971:2012 Medical devices – Application of risk management to medical devices 

EN 62304:2006 Medical device software – Software life cycle processes 

EN 62366:2008 Medical devices – Application of usability engineering to medical devices 

EN 1041:2008 Information supplied by the manufacturer of medical devices 

 

5. Intended use 

DentalEye 3.2 is used for acquisition, storage, display, manipulation and export of dental images and 

associated patient and anatomic information. The product is intended for use in dental examinations and 

procedures regarding teeth, jaws and surrounding tissue such as mucous membranes and skin. 
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Intended uses in dentistry include the following: 

 Acquisition, handling and export of radiographs and photographs. 

 Viewing and manipulation of radiographs and photographs for diagnostic purposes. 

 Viewing and manipulation of radiographs and photographs for insurance claims adjudication. 

 Viewing of radiographs and photographs for patient education and consultation. 

 

The DentalEye 3.2 system does not interpret data to form a diagnosis. The dentist bases the diagnosis on a 

combination of the images and examination of the patient. Since the DentalEye 3.2 software is usually 

used inside the examination room, there is a close correlation between the images and the patient in front 

of the dentist. 

 

No energy, e.g. X-ray exposure, is controlled from the DentalEye 3.2 system. This is always done from 

the X-ray system. 

5.1. Intended users 

The DentalEye 3.2 system is intended for use by, or under the direct supervision of, a licensed healthcare 

practitioner, with sufficient experience in dental procedures, such as a dentist or a dental hygienist. 

5.2. Intended patient population 

The DentalEye 3.2 system is intended for use on adult or child patients (from 0 years and up), after 

indication, requiring a dental procedure or dental examination. 

5.3. Indications 

When used for diagnostic purposes, the device will be used to diagnose and document diseases and 

conditions such as dental caries, periodontal disease, tooth and jaw injuries, in orthodontic treatment and 

other conditions that are encountered by general practitioners and specialists in the dental care field. 

5.4. Contraindications 

There are no known contraindications. 

6. Installation 

Before the product may be put to clinical use, it must be installed properly according to the Installation 

instructions. 

 

Installation is performed on one or several computers in a network. All computers connect to a common 

server that stores the DentalEye database with patient information and images. Each computer in a 

treatment room is a workstation with connected equipment such as sensors and cameras as well as third-

party software such as patient management systems and drivers. In DentalEye, some settings are stored 

centrally in the database and each workstation has additional settings that may be different between 

computers. 

 

 

C A U T I O N !  

Verify that there is a system in place to create regular backups of the SQL database and 

image store so that the information can be restored if the image database is lost! 
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When installing a workstation, the correct plugins needed for the attached equipment are selected. The 

drivers for the equipment as well as the plugin may contain additional settings, e.g. for image 

enhancement. Adjustment of these settings, calibration of the X-ray imaging system and monitor 

calibration must be performed according to the Installation instructions before clinical use takes place. 

 

 

W A R N I N G !  

The X-ray imaging system must be properly calibrated according to the Installation 

instructions! Inferior image quality could cause a risk of misdiagnosis or malpractice. 

 

 

W A R N I N G !  

The computer monitor must be properly calibrated according to the Installation 

instructions! Inferior image quality could cause a risk of misdiagnosis or malpractice. 

 

 

W A R N I N G !   

Image enhancement settings must be adjusted carefully according to the Installation 

instructions! Incorrect settings could lead to inferior image quality and cause a risk of 

misdiagnosis or malpractice. 

 

In the main menu of the software, the Preferences option is found in the System menu. When the 

preferences dialog is opened, a tab with user settings is shown where the user interface language is 

selected and the visual appearance can be adjusted. There is also a tab for license key settings. 

 

Additional settings are available via the Advanced button, but are only intended for installers and 

administrators with sufficient user rights. A warning message is shown when the advanced settings are 

opened. Refer to the Installation instructions for more information on these settings. 
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7. Instructions for use 

Below is a presentation of the basic functionality of the software – patient management, image 

acquisition, analysis and approval of images as well as file import and export. 

 

Please note that the appearance and functionality may differ depending on current settings and connected 

equipment. Refer to the Installation instructions for more information. All patient information in the 

examples below is fictitious. 

 

The Instructions for use are available from within the software via the Help menu or using the F1 key. 

The Instructions for use describe both the Pro and the Enterprise variant of the software. Some 

functionality is only available in one of the variants and there are sometimes differences in the user 

interface. Such differences are noted where applicable. 

 

 

W A R N I N G !  

Functions for image analysis, diagnosis, measurements and approval must only be used 

by a licensed healthcare practitioner, such as a dentist or a dental hygienist. Otherwise, 

there is a risk of misdiagnosis or malpractice. 

7.1. Overview 

The user interface of DentalEye is shown in figure 1. At the top of the main window are the main menu 

and a number of toolbars. When a patient is selected, the image card area is shown at the center. It 

contains the current image card with images in their respective positions or, alternatively, a template 

with empty image positions, ready for acquisition. At the bottom of the window there is a status bar that 

contains current information and messages. 

 

The name and ID of the current patient is shown in the title bar of the window, to the left in the status bar 

and in an identity label that is displayed over the lower part of the image card area when the computer 

has been left idle for a few seconds. 

 

The list pane to the left contains a list of the image cards belonging to the patient or, alternatively, a list 

of images. In the lower part of the list pane, properties for the currently selected object are shown. When 

an image card is selected, this area shows the properties for the current study and series. When one or 

multiple images are selected, image properties, anatomic information and exposure settings are shown. 

 

The currently selected image card is shown with a different background color in the list pane and a 

selected image or template frame is shown with a blue frame. Click an image to select it or press the TAB 

key repeatedly to step through the images. It is possible to select multiple image cards simultaneously by 

holding down the Ctrl key while clicking the next object. 

 

If the template is full and additional images are captured, they are placed in the extra-image pane below 

the image card area. Click and drag images to move them between different template positions or between 

the image card area and the extra-image pane. If an image is selected (with a blue frame around the 

image) and a new image is captured, the new image will be placed in the current position while the 

existing image is pushed to the extra-image pane. 

 



 

DentalEye 3.2 

Instructions for use 

DE32-IFU-EN-1.0 

2016-03-16 

 

8 (32) 

 

 

Figure 1. The main window during image capture 

There are different types of image cards. This is indicated with icons in the list pane (table 3). An image 

card usually contains a series of images which can be approved or not approved (see below). Images 

and image cards that are not approved are shown with a red top left corner in the image or in the icon. It is 

also possible to create local image cards containing images of different type from different series. 

 

Table 3. Different types of image cards in the list pane  

 An approved series. 

The series contains images of a certain type from a single treatment session.  

The series is ready to be exported. In DentalEye Enterprise, it may be transferred to a DICOM 

server but the transfer is yet to take place. 

 An unapproved series. 

The images were just captured or approval is deferred. The images cannot be exported. 

The series cannot be transferred to a DICOM server (DentalEye Enterprise only). 

 A series which is approved and stored in the DentalEye database as well as in a DICOM server 

(only visible in DentalEye Enterprise). 

 A series which is only stored in a DICOM server. The series may have been captured with a 

different system or it may have been deleted from the DentalEye database after transfer to the 

DICOM server. When the series is fetched, it is stored in the DentalEye database for quicker 

access, then the icon changes to the one above. 

 A local image card which may contain images from different series, of different type or from 

multiple treatments. A local image card may also contain a working copy of a series or a saved 

comparison. Local image cards may not be stored to a DICOM server. 
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7.2. Patient management 

DentalEye is typically used together with a patient management system (PMS). All patient information is 

entered into the PMS and passed on to DentalEye, e.g. when clicking a button in the PMS. DentalEye will 

then open the current patient record, ready for image capture. 

 

Such an integration between the PMS and DentalEye is created by the manufacturer of the PMS or 

configured during installation using various tools included with DentalEye. This setup must be performed 

according to the Installation instructions before clinical use. 

 

In addition, there is functionality included with DentalEye for managing patient records and personal 

data. In the Patient menu, the options New patient, Find patient and Patient information are used to 

add and search for patients and to edit personal information. The Find patient function can also be 

accessed from the toolbar and can be used if images need to be moved to a different patient. 

 

If DentalEye is started directly from Windows without using the PMS, the Find patient dialog will show 

up. Enter the patient's name or ID, or a part thereof, to find and open the desired patient. The wildcard * 

can be used as a part of the name or ID to find all patient who match the filter. 

 

 

Figure 2. The Find patient dialog in DentalEye Pro 

 

In DentalEye Pro (figure 2), the search is only performed in the DentalEye database. In DentalEye 

Enterprise, a search for patients can also be performed on one or multiple DICOM servers, which may 

contain patient information and images from other systems than DentalEye (figure 3). 
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Figure 3. The Find patient dialog in DentalEye Enterprise 

 

 

C A U T I O N !  

If the PMS or its connection to DentalEye becomes unavailable, there is a risk for 

delayed or cancelled treatment. To avoid this, patient information can be added directly 

to DentalEye instead of waiting for the PMS to become available. 

7.3. Templates, series and image cards 

Templates are used in DentalEye for arranging images according to anatomic region and to facilitate 

image capture in a suitable sequence. There are a number of predefined templates, e.g. bitewing and full 

mouth series (FMX). Additional custom templates can be created, refer to the Installation instructions 

for more information. 

 

 

Figure 4. Image frames in the BW4 template 

The desired template is selected prior to capture and empty frames are shown in the image card area 

(figure 4). The frames indicate the sequence number and the rotation of the image upon capture. 

 

When a template is created, anatomic information may be associated with each position. There are also 

templates where there is no anatomic information associated with the frames. When an image is placed in 

a frame, the anatomic information of that frame is associated with the image. This information is 

displayed in the lower part of the list pane and it can also be modified there. The anatomic information 

can also be edited with the function Image information (see figure 7 in the image management chapter). 
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In some cases, images without anatomic information cannot be transferred to a DICOM server. In such 

case, a message is shown that the anatomic information needs to be supplemented before transfer may 

take place (DentalEye Enterprise only). 

 

A series is a collection of images captured during the same treatment session, where all images are of 

the same image type (e.g. intraoral X-ray, panoramic or photograph). In DentalEye, a series is generally 

stored in a specific template, e.g. BW4. An approved image card containing a series is ready to be 

transferred to a DICOM server (DentalEye Enterprise only). 

 

Images of different types, taken during the same treatment session, should be stored in different series but 

may be associated with the same study. For example, intraoral X-rays may be captured into the BW4 

template in DentalEye and stored as a series. During the same treatment session, photographs are captured 

into a camera template and stored as a second series. Both series are shown as image cards in DentalEye 

and may be associated with the same study during approval, prior to transfer to the DICOM server. 

 

DentalEye can also use local image cards. Such image cards do not need to contain a template and may 

hold images from several different series taken during different treatment sessions. Local image cards 

allow free placement of images of different types, e.g. radiographs as well as photographs, which may be 

useful for presentation or comparison. The images placed on a local image card are always copies of 

images that are stored in the series where they were originally captured. Deleting an image from a local 

image card will only delete the copy; the original image always remains in its original series. 

7.3.1. Image cards captured with DentalEye 3.1 

In previous versions of the software (DentalEye 3.1), a local image card (green icon) was usually saved as 

a ”working copy” of each series upon approval. In addition, DentalEye 3.1was typically configured to not 

display the original series (black icons) once they had been approved. These settings are no longer 

available in DentalEye 3.2. 

 

When existing patients are opened, with images captured using a previous DentalEye version, the list 

pane may therefore contain duplicates of previous treatment sessions; existing series with black icons and 

local image cards with the same name but green icons. 

 

Often, these duplicates contain identical information. The local image card copies may be deleted without 

losing images from the series. Sometimes, however, the images may have been rearranged and image 

enhancement been performed in the local image cards but not in the original series. All such 

modifications will be lost if the local image cards are deleted. 

7.4. Image capture 

First select the desired template from the template menu in the toolbar and then click the icon Show 

template. This will create a new, unapproved series in the list pane. If the capture is aborted the empty 

series will be deleted. 

 

The application might be configured to prompt for referrer. If so, select the person responsible for 

approving the series at a later time. 

 

The patient's name and ID are clearly shown on an identity label over the lower part of the image card 

area. The purpose is to alert the user if the wrong patient is selected in the application - this could e.g. 

happen if a new patient is selected in the PMS but the previous patient is still open in DentalEye. 
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W A R N I N G !  

Verify that the correct patient is selected before image capture! 

Storing images to the wrong patient could imply a risk of misdiagnosis or malpractice. 

 

 

If images were captured to the wrong patient by mistake, the series can be moved to the correct patient 

before approval. See chapter 7.5. 

 

Empty template frames are now shown in the image card area. The capture sequence and a rotation 

indicator are shown in the frames. The first frame in the sequence is selected, as indicated with a blue 

frame (see figure 5). As images are captured, they are placed in the template frames and each image is 

assigned the anatomic information associated with the frame. The selection is moved to the next frame 

in the sequence. 

 

Click another frame to select it and override the predefined sequence of the template. When the next 

image is captured, it will be placed in this frame. If an image was already present in the frame, the 

previous image will be moved to the extra-image pane in the lower part of the image card area. This 

could be useful when re-capturing an inferior image. The new image will receive the anatomic 

information of the frame and the previous image will keep the same information. 

 

If a template is filled with images in all positions and additional images are captured, any excess images 

will be pushed into the extra-image pane. These images will lack anatomic information until they are 

moved to a template frame or until the information is entered manually. 

 

 

W A R N I N G !  

When an image is placed in a template frame, anatomic information is assigned to the 

image. If an image is placed in an incorrect position, or if the wrong template is used, 

the image may be displayed with incorrect clinical information, which could imply a 

risk of misdiagnosis or malpractice. 

 

If an image was placed in an incorrect position, its orientation may also be incorrect. If so, click the image 

and drag it to the correct position and then adjust the orientation with the Rotate tool in the Image 

toolbar. 

 

If, during capture, it is decided to select a different template, select the desired template in the template 

menu in the toolbar. A dialog is presented where the user decides whether to start a new series and leave 

the existing series unapproved, or whether to switch template in the existing series. Select the latter 

option. Empty template frames are then displayed in the image card area and all images are pushed to the 

extra-image pane. Move all images to their correct positions and adjust their orientation so that the 

anatomic information is correct. 

 

When image capture is complete, adjust all images so that their position and orientation are correct. Next 

apply image enhancement and any other manipulations on each image to facilitate diagnosis, see chapter 

7.6. Finally, the series may be approved, see chapter 7.7. 

 



 

DentalEye 3.2 

Instructions for use 

DE32-IFU-EN-1.0 

2016-03-16 

 

13 (32) 

 

All images are stored to the DentalEye database immediately upon acquisition. Thus, it is not necessary to 

click the Save button to save the images. If the patient is closed without saving, the series will be stored 

as an unapproved series and it can be retrieved for approval at a later time. The Save function is used to 

change the description, referrer and study properties of the series and whether to save it as an approved 

or unapproved series. 

7.4.1. Direct capture of X-rays 

Use this method for image capture with intraoral sensors, a phosphor plate scanner or a panoramic X-

ray device which is connected directly to the computer. DentalEye on this computer must first be 

installed with the correct plugin and the system must be calibrated for the connected equipment. Refer to 

the Installation instructions. 

 

Each plugin is displayed with its own toolbar at the top of the main window with buttons to activate and 

stop capture. A green indicator shows Active when the equipment is ready for capture and a red indicator 

shows Idle when the equipment is disconnected. 

 

 

Figure 5. Empty template with active plugin, ready for capture 

 

Open the current patient and select the desired template for the examination. Click Activate capture in 

the plugin toolbar. The status indicator shows Active. Some sensors can only be active for a limited time. 

If so, the remaining active time is shown in a window until the plugin reverts to Idle. 

 

Place the sensor or the phosphor plate in the first position and expose. The image is placed in the template 

in the next frame in the sequence. Move the sensor to the next position and expose. Repeat the procedure 

until all images are captured. 
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7.4.2. Image capture with shared equipment 

When multiple treatment rooms share a common unit, for example a phosphor plate scanner or a 

panoramic X-ray device, the Developer function is recommended. The equipment is connected to a 

computer that must be installed as a Developer server and the computers in the treatment rooms must be 

installed as clients of this Developer server according to the Installation instructions. Developer 

workflow is as follows: 

 

Step 1 

On the computer in the treatment room, open the patient and select the desired template. If a scanner is 

used, expose phosphor plates in the treatment room in positions corresponding to the selected template. 

 

Step 2 

Go to the developer computer. A menu is shown with all treatment rooms and patients (figure 6). Click 

Refresh if the current patient is not shown. If the menu is not shown, display it with Ctrl-D. Select the 

room from the menu. The developer will open the correct patient with a new series using the selected 

template. The series is locked on the computer in the treatment room while it is open on the developer. 

 

 

Figure 6. The developer menu 

 

Step 3 

Scan the phosphor plates or capture the images in the correct sequence. Depending on the configuration, 

the series can be saved automatically when the template is full or after a certain number of seconds after 

the last plate. Approval is not performed on the developer and the patient is closed with the menu re-

appearing, ready for the next patient. 

 

Step 4 

Go back to the treatment room. The images appear on the screen in the selected template. If there is a 

delay, the image card area can be refreshed by pressing F5. The images are not yet approved and may be 

moved and rotated, as needed. 

 

Step 5 

When the series and the images are correct, the series is approved in the treatment room. 
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W A R N I N G !  

Observe correct orientation of the phosphor plates! 

Images with incorrect rotation or mirrored images could imply a risk of misdiagnosis or 

malpractice. 

7.4.3. Image capture with cameras 

DentalEye can capture photographs from intraoral cameras or digital cameras. Intraoral cameras are 

typically connected via the Video plugin. Photographs are captured with Camera WIA plugin or 

Autoimport plugin which transfers all images at a time directly or using a memory card reader. The 

camera and the plugin must first be installed and configured according to the instructions of the device 

and the Installation instructions. 

 

When an intraoral camera is used with Video plugin, a live video feed is displayed in a window on the 

screen. Press F to show the video window full-screen. Freeze the video feed and then select Capture to 

save the image or release the frozen image to try again. Captured images are placed in a list to the right of 

the screen. Repeat the procedure until all images are captured. Press Esc to close the video window. 

 

When the video window is closed, all captured images are transferred to DentalEye and added to the 

current series. On some cameras, it is possible to configure buttons to freeze, capture and release images. 

It is also possible to freeze/release using the space bar and Enter to capture an image. 

 

When capturing images with a camera, a template suitable for photographs should be used instead of a 

template designed for X-rays. Photographs captured to an X-ray template may be converted to grayscale 

upon approval. If an X-ray template is selected when photographs are captured, the application will 

automatically switch to a more suitable template to prevent loss of color information. 

7.5. Image management 

Permanent changes to image cards and images should be performed before the series is approved. Images 

may need to be moved or rearranged if they are in the wrong place. It may also be necessary to 

supplement the image information. 

7.5.1. Locked series 

A series may sometimes be locked and cannot be modified until it is unlocked. When an unapproved 

series is locked, the reason is often that the same series was already opened on a different computer, 

possibly by another user in the network. The name of the other computer and user are shown so that the 

series can be closed where it was left open. 

 

When opening a series, it may also become locked if the user aborts the operation before the entire series 

is shown. Re-open the series to unlock it. Series may also become locked if there is a network error so 

that the image store cannot be reached. Changes must not be made until the system is operational. 

7.5.2. Selecting images 

Click on an image in an image card to select it. Additional images may be selected by holding down the 

Ctrl key while clicking the next image. All images may be selected with the Select all option in the Edit 

menu or by pressing Ctrl-A. Undo the selection by clicking the image card area between the images. 
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7.5.3. Moving images on an image card 

Unapproved images in a series may be moved to another position in the image card or to or from the 

extra-image pane by clicking the image and dragging it to a new position. Approved images in a series 

may not be moved. Images in a local image card can be moved freely whether they are approved or not. 

In addition, the size of an image on a local image card can be adjusted by dragging the corner of the 

image. 

7.5.4. Deleting images 

Approved series and approved images cannot be deleted. Unapproved images can be deleted permanently 

by selecting the image and clicking the Delete button in the toolbar or pressing the Delete key on the 

keyboard. This is only possible if the user has the right to delete images which is configured according to 

the Installation instructions. The application may be configured to prompt for a reason for deleting the 

image (DentalEye Enterprise only). If the last image on an image card is deleted, the image card will also 

be deleted. If no image is selected, the application prompts whether to delete the entire series, provided it 

is unapproved. 

 

Please note: 

When an image is deleted, it is removed permanently from the database. However, a backup copy of the 

image is stored in the system and if the image was deleted by mistake, it may be possible to restore the 

image. This can only be performed by the manufacturer or a system administrator. 

7.5.5. The clipboard 

The clipboard in DentalEye can be used to copy or move images. The clipboard is also used when 

comparing images from different patients in the Presentation overview (see below). The content of the 

clipboard is shown in the list pane when Clipboard is selected in the list pane menu or in the Window 

menu. 

 

To place images on the clipboard, select one or more images in an image card and click Copy from the 

Edit menu or press Ctrl-C. The clipboard can contain no more than nine images at a time. To remove 

image copies already on the clipboard, use Clear clipboard in the Edit menu. 

 

Unapproved images copied to the clipboard may be transferred to a different image card on the same 

patient or to a different patient, see below. 

 

If an approved image was copied, it is also available in the Windows clipboard and can be pasted into 

other applications. This is a way of exporting images from DentalEye. Unapproved images cannot be 

copied to the Windows clipboard.  

7.5.6. Moving images to a different image card 

An image can sometimes be captured to the wrong series, e.g. if a new series is not opened before capture 

and the previous series was unapproved. Images may also be captured to the wrong patient by mistake. As 

long as the images are not yet approved, they can be moved to a new series or to another unapproved 

series, on the same patient or to a different patient, using the clipboard. 

 

Open the image card with the images that need to be moved and select Clipboard in the list pane menu. 

If the clipboard already contains images, they can be removed with Clear clipboard in the Edit menu. 

Select the image or images that need to be moved and choose Copy to put them on the clipboard. 
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If the images need to be moved to a different patient, use the Find patient function or the patient 

management system to search for the correct patient and open it. 

 

Create a new series by selecting the desired template and click Show template in the toolbar, or select an 

existing series. This series must also be unapproved in order for the images to be moved there. If the 

series is approved, the approval can be changed, se chapter 7.7. If approved images that have also been 

transferred to a DICOM server need to be moved, the images in the DICOM server also must be moved 

by a system administrator (DentalEye Enterprise only). 

 

When the desired destination (an empty template or an unapproved series) is visible in the image card 

area, once again open the clipboard where the images to be moved are visible. Click and drag the images 

from the clipboard to the desired position. A warning will be shown that the images will be deleted from 

the original series. Confirm the warning to move the images. When all images are moved, both the new 

and the old series need to be reviewed and approved. 

7.5.7. Moving a series to a different patient 

Sometimes the wrong patient may be selected by mistake when capturing a series of images. As long as 

the series has not yet been approved, it can be moved to a different patient using Move series to another 

patient in the Edit menu. 

 

If the series has already been approved, despite the fact that it was captured to the wrong patient, the 

approval must be withdrawn before the series can be moved, see chapter 7.7. If the series was approved 

and it has been transferred to a DICOM server, a system administrator must delete the series from the 

incorrect patient on the DICOM server (DentalEye Enterprise only). 

 

When Move series to another patient is selected, the Find patient dialog is shown. Search for and open 

the correct patient. When the patient is selected the application prompts whether to move the series to this 

patient. Confirm to move the images. Once the series has been moved, it needs to be approved on the new 

patient. 

7.5.8. Image information 

Select an image and use the function Show image information in the toolbar or in the Image menu to 

show and edit the information below: 

 

 image type, e.g. intraoral X-ray, panoramic, photograph 

 anatomic information 

 exposure information 

 DICOM information (can be viewed but not edited) 

 

The image information is also shown in the list pane when an image is selected. The image received its 

anatomic information from a template frame associated with predefined Anatomic descriptions, which 

can be edited or supplemented using the function Show/Edit anatomic descriptions in the Tools menu. 

If images were captured without a template, or if a template without anatomic information was used, the 

images can be assigned such information using the function Show image information. See figure 7 

below. 
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Figure 7. The image information window 

 

It is important that every image is assigned complete and correct image information in order for 

DentalEye and other systems to render and store the image correctly. Transfer to DICOM server will not 

be possible if the image information is incomplete (DentalEye Enterprise only). 

 

 

C A U T I O N !  

Verify that anatomic information and other relevant image information is correct before 

approving images. Incorrect or incomplete image information may lead to decreased 

diagnostic capability. 

7.5.9. Local image cards and comparisons  

Local image cards may contain images of different type from different series. It is possible to change the 

size of images on a local image card by clicking and dragging the corners of the images. Images can also 

be moved around freely without being restrained to template frames. However, it is possible to show a 

template in a local image card for easier image adjustment: select a template in the toolbar and use Show 

template in image card in the Image menu. If an image is dragged to a template frame, the image size 

adjusts to the frame. 

 

There are several ways of creating a local image card: as a working copy of a series, as a compilation of 

images from different series and by saving a comparison. 

 

Select Save as in the File menu and then select Save as a local image card to save a working copy of an 

approved series. An image card with the same name as the original series but with a green icon shows up 

in the list pane. The local image card contains copies of the images in the approved original series. 

Changes to the image copies in the local image cards do not affect original images in the series. 
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To create a compilation, click the New button in the toolbar or in the Image menu. A new, empty local 

image card is created and shown in the image card area. Change the list pane to Images which will show 

a list of all images belonging to the patient. Click and drag the desired images to the empty image card 

and adjust their position and size. Click Save to store the local image card with a descriptive name. 

 

Comparisons between series can also be saved as local image cards. Compare series by first selecting a 

series in the list pane to display it, next select one or more additional series by holding down the Ctrl key 

while clicking the desired series. All images of the selected series are shown simultaneously in the image 

card area with the most recent on top (figure 8). This may be useful for comparing the current 

examination with the one from last year, for example. The comparison can be saved as a local image card 

with Save as. 

 

 

Figure 8. A comparison of two series 

7.5.10. Presentation overview 

Presentation overview is used to compare and display images, e.g. for patients. One or more images are 

shown in full screen mode with menus and image tools disabled (figure 9). Select the image or images to 

be displayed and press the F7 key or click Presentation overview in the toolbar or in the Tools menu. If 

no image was selected, all images on the image card are shown in the presentation overview. There is a 

maximum of nine images that can be displayed in the overview. Click one of the images in the 

presentation to display only that image in full screen. Click the image again to return. To exit the 

presentation, click the background between images, press F7 again or press Esc. 

 

Presentation overview can also be used to display images from different patients simultaneously. The 

images to be displayed must first be copied to the clipboard and can then be displayed and compared in 

the presentation overview. If there are images on the clipboard, those images are always displayed instead 
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of those selected on the image card. Use Clear clipboard in the Edit menu to revert to displaying selected 

images in the presentation overview. 

 

 

Figure 9. Images from different series displayed in the presentation overview 

7.6. Analyze and manipulate images  

Permanent image manipulation, e.g. to compensate for imperfect image quality, should be performed 

prior to approval. Image enhancement combined with image analysis to facilitate diagnosis may be 

performed after approval. For example, brightness and contrast can be adjusted in an X-ray image to help 

identify caries. 

 

When analyzing an image, it is recommended to switch to review mode by double-clicking the image or 

by pressing the Enter key when the image is selected. In the review mode, the image is displayed full-

screen with all image and analysis tools available (figure 10). Zoom the image by scrolling the mouse 

wheel or by pressing + and – on the numeric keypad. 

 

Press the TAB key in review mode to switch to the next image. Exit review mode by double-clicking the 

image again, or by pressing Esc. 

 

Click and drag in the image to adjust brightness and contrast in the review mode. It is possible to adjust 

brightness and contrast in image card mode as well, but only if Ctrl is pressed before clicking and 

dragging in the image, otherwise the application will try to move the image. 
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Figure 10. An image is displayed in the review mode. Tools for brightness/contrast and histogram are open to 

the right of the image.  

7.6.1. Tools for image analysis and enhancement  

The functions in the Image and Analysis toolbars are used for image review and enhancement. 

Additional tools are available in the Image menu. Before approval, some tools are unavailable or 

restricted. 

 

There are common image enhancement functions like brightness/contrast, noise reduction and edge 

enhancement. The orientation can be adjusted with functions for rotation and mirroring and images can be 

cropped. There are also tools for annotations and measurements. 

 

Repeated application of some image enhancements, such as edge enhancement, may introduce artifacts 

(defects) and degrade the image quality. Prior to approval, such tools can be applied only once. 

 

If image manipulation is performed in the review mode, it may be easier to assess the result. When image 

enhancement is performed on the image card, it is possible to select multiple images to apply the same 

tool to all images simultaneously. 

 

The image manipulation tools are described below in the order they appear in the Image and Analysis 

toolbars (figures 11 and 12). 
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Figure 11. Tools in the Image toolbar  

 

Reset  

Aborts the current tool and resets the mouse pointer.  

 

Undo all except orientation  

The image is reset to its original appearance, before any manipulation took place. However, any rotation, 

mirroring or cropping is left in place. If manipulations performed after approval are undone, the image 

will revert to the state at the time of approval. 

 

Undo 

The most recent operation is undone. Click repeatedly to undo all operations one at a time.  

 

Redo 

The most recently undone operation is redone. Click repeatedly to redo undone operations one at a time.  

 

Rotate 

The image is rotated 90 degrees clockwise. 

 

Show/Hide brightness/contrast  

A window is displayed (see figure 10), where brightness/contrast can be adjusted by moving a cursor. 

Right-click the tool window to undo the changes. 

 

Show/Hide histogram  

A window is displayed (see figure 10) with the histogram of the image that shows the distribution of 

grayscale levels. Right-click in the tool window to access options such as auto level, which will increase 

the contrast of the image by stretching the grayscale information to use all available levels. There are also 

manual cutoff controls below the histogram. 

 

Invert 

The color scale of the image is inverted. This tool can e.g. be used with X-rays to assist in detecting fine 

details or diagnosing caries. 

 

Optimize brightness  

This tool activates a special cursor used for selecting a region in the image characteristic for the current 

examination, such as a region where caries can occur. The grayscale of the entire image is then optimized 

based on the selected region. The tool can only be applied to approved images, and only once. Undo the 

tool in order to reapply it for a different region in the image. 

 

Equalization 

The tool displays a highlight region that can be moved over the image. Within the region, histogram 

equalization is performed which enhances contrast to allow fine details to stand out more clearly. When 

the tool is active, scroll the mouse wheel to change the size of the region. 

 

Noise reduction  

A filter is applied that reduces noise but may cause fine details to be lost. Hence, use this tool with 

caution.  
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Edge enhancement  

A filter is applied that increases contrast near edges and gradients and the image may seem sharper. The 

arrow next to the button opens a menu where the degree of edge enhancement is selected (1-10). This 

filter may introduce artifacts and enhance noise in the image, so it must be used with caution. For this 

reason, only one application of this tool is allowed for unapproved images (undo and select a different 

degree if the result is not satisfactory). Sometimes the result is improved if noise reduction is applied 

prior to edge enhancement. 

 

 

 

Figure 12. Tools in the Analysis toolbar  

 

Magnifier 

An enlarged region is displayed that can be moved over the image. 

 

Zoom 

Click and drag to create a rectangle in the image to magnify the selected area or click multiple times in 

the image to zoom repeatedly. Use the next tool to revert. It is also possible to use the mouse wheel or + /- 

on the numeric keypad to zoom. 

 

Fit image to frame 

Resets the size of the image so that it fits in the window or image card frame.  

 

Fit image to screen resolution 

Changes the size of the image so that one pixel in the image corresponds to one pixel on the screen, in 

order to optimize image rendering. 

 

Measurement calibration 

This tool is used to select a known distance in the image, later used for calibrating measurements. See the 

separate chapter on measurements below. 

 

Ruler 

Select a line with two endpoints to measure a distance based on the most recent calibration performed. 

 

Multi line ruler 

Measure the distance along a curved line by clicking multiple times in the image with the left mouse 

button to place marks. Use the right mouse button to select the endpoint. The marks can be adjusted by 

clicking the line to show all marks and then moving the marks. The measurement is based on the most 

recent calibration. 

 

Annotation tools 

This button toggles display of annotations in the image. Next to the tool button and in the Image menu 

there is a menu of different tools: lines and objects, measurements and text annotations. If there are 

annotations in the image, an icon is displayed in the top right corner of the image, even when annotations 

are hidden (figure 13). When annotations are displayed, the menu that opens when the image is right-

clicked is replaced by an annotation tool menu. 
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Crop 

A crop tool is available in the Image menu under Orientation. Crop is primarily intended for photographs; 

X-rays should not be cropped as this may lead to loss of clinically valuable information. If an image is 

cropped before approval, the removed image information is lost upon approval. In order to crop before 

approval the user therefore must have the right to delete images. The Undo all except orientation 

function will not restore a cropped image. This can be done, however, with the Undo all function in the 

Image menu. 

7.6.2. Measurement and calibration 

The Ruler and Multi line ruler can be used to measure the distance along a straight line or a curved line 

in an image (see figure 13). The measurement is only valid if the image was calibrated with the 

Measurement calibration tool using an object with known size in the image. The calibration is only 

valid in the current image. If a new calibration is performed, all existing measured values in the image are 

changed. 

 

To obtain an accurate measurement in an X-ray image, the line to be measured must lie in, or close to, a 

plane parallel to the sensor or phosphor plate and perpendicular to the X-ray beam. 

 

The calibration can be performed using any object visible in the image, the size of which can be measured 

accurately, such as a sensor holder or a root canal file. The calibration object must also lie in a plane 

parallel to the sensor and at the same distance from the X-ray source in order to minimize parallax and 

divergence effects. To eliminate the problem of aligning the calibration line and the measured line in the 

same plane, it is recommended to use a spherical calibration object, such as a steel ball bearing with 

accurately measured diameter. 

 

The measurement accuracy of the software is ± 0.3 mm in laboratory tests. In a treatment situation the 

major source of error is distortion due to imperfect parallelism. Depending on the anatomy and 

positioning of X-ray tube and sensor, it may in favorable cases be possible to obtain a measurement 

accuracy in the interval ± 0.3–0.5 mm, based on clinical experience from endodontics. 

 

 

W A R N I N G !  

Calibration must be performed for each measurement! 

If uncalibrated measurements are used, there is a risk of misdiagnosis or malpractice. 

7.7. Approval 

Unapproved images and series are displayed with a red top left corner (figure 13). Approved images and 

series are displayed without the red corner. A series is approved when all images in the series are 

approved. 

 

It is possible to specify a referrer of the examination before capture. The referrer is the person who is 

supposed to approve the series at a later time. 

 

Approval of series must only be performed by a licensed healthcare professional, such as a dentist or a 

dental hygienist. Security permissions controlling which users have the authority to perform approval 

shall be configured according to the Installation instructions. 
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By approving a series, the healthcare provider certifies that the series has sufficient diagnostic quality and 

that the images belong to the current patient. The approval confirms that the images are correct with 

respect to anatomy, orientation and position and that the image quality is acceptable. 

 

Please note that approval is issued with the function Save and approve series, but it is not necessary for 

images to be approved to be saved. All images are stored directly to the database when captured. 

However, it is possible to alter the name of a series and other information, which will be saved during 

approval. 

 

Typically, a series of images are captured, rotated and rearranged according to the template and then 

some image enhancements, such as brightness/contrast, are applied. Finally, the series is saved and 

approved. 

 

However, there may be some situations when a series is not approved immediately: 

 

  Approval shall be performed by another person or at another location, for example when using 

the Developer or if another person is the referrer of the examination. 

 

  The treatment session is not completed and capture will continue in the same series at a later 

time, e.g. during endodontic treatment. 

 

  There is a risk that the images may need to be re-captured, possibly as a result of inferior image 

quality or if proper image orientation cannot be determined.  

 

  It is discovered that images may not belong to the selected patient and they must be moved to the 

correct patient before approval.  

 

 

 

C A U T I O N !  

Ensure that all images are approved, once the image quality is found to be acceptable for 

diagnosis, the orientation is adjusted and all images provided with correct anatomic 

information, e.g. by placing them in a template. 

 

Unapproved images must not be used for diagnosis and cannot be exported or 

transferred to a DICOM server. Incorrect or incomplete image information may lead to 

decreased diagnostic capability. 

7.7.1. Images manipulated after approval  

Images can be manipulated before as well as after approval, see chapter 7.6. Before approval, e.g. image 

enhancement to permanently improve the image quality is to be performed. Such manipulations are saved 

upon approval and cannot be undone later. 

 

After approval, it may be useful to use operations that facilitate diagnostics, e.g. adjust brightness/contrast 

or apply edge enhancement. An indicator is then displayed on the image in the form of a red, hollow 

corner to alert the user that the image is different from its approved state. See figure 14 below. 
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Figure 13. An unapproved image (red corner). The top 

right icon indicates that an annotation (measurement) 

is present in the image. 

 

Figure 14. An approved image saved as a derived 

series (D) to the DICOM server and then modified after 

approval (red, hollow corner). 

 

Image manipulations performed for diagnostic purpose after image approval do not need to be saved. If 

not saved, the series will revert to the approved state the next time it is opened and no red corner will be 

displayed. If the image is to be saved again, the approved series will not be overwritten. Instead, the 

application prompts whether to save a copy of the image in a local image card or as a new copy of the 

series (Derived series) which can be transferred to a DICOM server (DentalEye Enterprise only). In the 

latter case, a red D is displayed in the top, right corner of the image (figure 14). 

7.7.2. Unapproved series list  

If series were not approved at the time of capture and approval is deferred, e.g. to be performed by 

another person, it is possible to search for all series that need approval with the tool Unapproved series 

list in the toolbar and in the Tools menu (figure 15). The search can be filtered per clinic and per referrer. 

Click a series in the list to open it in DentalEye to review and approve it. 

 

 

Figure 15. The unapproved series list 

7.7.3. Transfer to DICOM server (DentalEye Enterprise only) 

Once a series is approved, it is ready for transfer to a DICOM server. A computer in a treatment room 

may be configured to transfer approved series to a DICOM server and if so, transfer takes place 

immediately after approval. A message is displayed that transfer is in progress and when the series is 

transferred, its icon in the list pane will contain the yellow database symbol (see table 3). 
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Alternatively, computers may be configured not to transfer images directly to a DICOM server. In that 

case, the transfer may take place between servers from the DentalEye database to the DICOM database. 

Such a setup may e.g. be configured to transfer all new approved series every night or once a week. When 

the transfer has occurred, the yellow DICOM icon is displayed in the list pane for the transferred series. 

 

One reason to defer the transfer might be to retain the possibility to change approval and perform 

corrections before series are copied to the DICOM server. 

7.7.4. Change approval  

In extraordinary cases it might be necessary to change approval for a series so that it once again is 

unapproved. This might be needed if a series was captured to the wrong patient but the series was 

mistakenly approved before the error was discovered. 

 

Select the series or an image and use Change approval in the Image menu. If the approval is changed for 

an image, the entire series will become unapproved. 

 

A special user permission in the system is required to change approval which is configured according to 

the Installation instructions. Such authorization should not be provided to everyone but should be 

reserved for a clinic manager or a system administrator. 

 

Pay attention to whether a series whose approval needs to be changed has already been transferred to a 

DICOM server (DentalEye Enterprise only). If so, the yellow DICOM icon is displayed in the list pane 

for the transferred series, but only while it is still approved (see table 3). 

 

If the series is stored on the DICOM server, it must be deleted manually from the DICOM server by a 

system administrator when the approval is changed (make sure that the series is still stored in the 

DentalEye database before it is deleted from the DICOM server, or else it will be permanently lost). If the 

series is left undeleted on the DICOM server, any changes made to the series in DentalEye before it is re-

approved will not be transferred to the DICOM server and the old faulty series will remain there. If the 

reason for the changed approval was to move the series to another patient, the series will remain on the 

old patient in the DICOM server unless deleted manually. 

7.8. Import images 

The Import images function in the Image menu is used to open one or multiple image files and import 

the images to a patient in DentalEye. X-rays or photographs can be imported from common image file 

formats such as JPG, DICOM and several other formats. In DentalEye Pro, it is also possible to import 

documents, such as Word files, as well as video clips (not available in DentalEye Enterprise). 
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Figure 16. A panoramic X-ray is imported from a file. Images can be previewed in the import dialog.  

 

Imported files are placed on an image card in DentalEye (figure 16). If an unapproved series is open in 

DentalEye, the application will attempt to import the images to the open series. Otherwise, a new series is 

started. If a suitable template is selected prior to import, the images are imported into the template in the 

correct sequence. An image is only imported to a template if its type corresponds with the template. If the 

image is of a different type, the application will switch to a more suitable template before importing the 

image. If needed, change the template again and drag the images to the correct position before approval. 

 

For example, if an X-ray template is selected and the user imports all images from a folder containing 

both X-rays and photographs, the application will first try to import the X-rays to the selected template 

but then open another template that can accept photographs. Thus, importing images of different type may 

cause the images to be imported into different series. As long as the series are unapproved, it is possible 

to move the images between the series using the clipboard (see chapter 7.5). 

 

DICOM files can be imported separately or as a DICOMDIR. A DICOMDIR file acts as a directory that 

can contain a number of DICOM files in a folder structure and contain images belonging to multiple 

patients. If a DICOMDIR is included with the images, it is recommended to import the DICOMDIR file 

instead of all the separate files and then the application will import all images automatically. 

 

A DICOM file contains both image and patient information and is normally imported as an already 

approved series. If the patient information in the DICOM file is inconsistent with the currently selected 

patient in DentalEye, a message is displayed with the patient information found in the DICOM file. If the 

user confirms the import, DentalEye will switch to the patient corresponding to the DICOM file or create 

a patient with this identity if it was not found in the database, then import the image to the patient. 
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It is not uncommon for images belonging to the same patient, but captured on different systems, to use 

different formats, e.g. for patient ID. The application may then interpret this as a DICOM file belonging 

to a different patient when, in fact, it belongs to the currently selected patient. If the patient identity is 

correct, check the box Save all on currently selected patient to force the application to import the 

images to the selected patient. Verify that the image actually belongs to the currently selected patient in 

DentalEye. 

 

When importing images in non-DICOM format, there is no patient information in the file. Use the name 

of the file or other labeling, e.g. on an optical disc, to verify that the image in fact belongs to the currently 

selected patient in DentalEye. 

 

 

W A R N I N G !  

Verify that the correct patient is selected before images are imported! 

Storing images to the wrong patient could imply a risk of misdiagnosis or malpractice. 

 

If images are often imported from a specific folder or drive, it may be convenient to use Manual import 

plugin which imports images from a folder or Autoimport plugin which imports all images in a selected 

folder and then optionally deletes all files, which is useful e.g. when importing images from a digital 

camera memory card. See the Installation instructions for more information. 

7.9. Export images 

An approved image can be copied out of the system using the Export images function in the Image 

menu. Unapproved images cannot be exported. Images can e.g. be exported to an optical disc or a USB 

stick to be sent to another practice or to be imported to another imaging system. Image files can also be 

exported as e-mail attachments. 

 

When Export images is selected, the export dialog is shown (see figure 17). First select a folder or a drive 

as the destination for the exported images, such as the desktop, a CD burner or a USB stick. 

 

Next, in the Source list, select what to export, e.g. the selected images or all images of the patient. If the 

current image card contains approved images, it is possible to select all images in current series as well as 

a screen shot of the image card with the option Current series layout. 
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Figure 17. Images exported to JPG files using the export dialog 

 

File format 

In DentalEye Pro, the JPG format is the default but DICOM and other formats can be selected. In 

DentalEye Enterprise, DICOM format is the default. 

 

To reduce the risk of exported images being confused with images from another patient, it is 

recommended to export images in DICOM format, since patient information is stored together with the 

image in a DICOM file. DICOM files can be imported in most medical software but cannot usually be 

opened in standard office software. 

 

When multiple DICOM files are exported, the option to create a DICOMDIR can be checked. A 

DICOMDIR file acts as a directory of DICOM files and may facilitate importing the images to another 

system. 

 

When files are exported in a format other than DICOM, such as JPG, the info label option is active. Select 

this option to place a label with date, time and patient identity over the bottom of the exported image. 

This may reduce the risk of confusing the image with another patient. Exported images are then saved to 

files with names containing patient ID, date and time. 

 

When exporting to formats other than DICOM, an indicator in the form of an “F” is placed in the upper 

right corner to indicate correct orientation for review or import to another system. 
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W A R N I N G !  

Verify that exported images are labelled with patient information! 

Images without patient information may be stored to the wrong patient, implying a risk 

of misdiagnosis or malpractice. 

 

If images are often exported to a specific folder or drive, it may be convenient to install and configure 

Export plugin which then exports files to this folder at the click of a button. See the Installation 

instructions. 

 

Printing is another way of exporting images and image cards to a standard printer. DentalEye Enterprise 

can also print to a DICOM printer. Select Print in the File menu and select the images to be printed in the 

same way as when exporting files. Only approved images can be printed. If an image card contains both 

approved and unapproved images, only the approved images are printed. 

7.9.1. Example: export images to a CD 

This example is used to illustrate image export to an optical disc, such as a CD. 

 

1. Check that the computer is equipped with a recordable optical drive. Insert an empty CD, 

DVD or Blu-ray disc. Close any messages that are displayed. 

2. Open the patient and the image card containing the images to be exported. Images must 

be approved. Select the desired images unless all images on the image card are to be 

exported. 

3. Select Export images in the Image menu. Select the optical drive in the Folder box at the 

top by pressing the Browse button. The optical drive or a USB stick are often found under 

“Computer” in the list. 

4. Select the images to be exported under Source. For example Selected images to export 

those images that were selected or All images in current series. It is also possible to 

export all images of the patient. 

5. Select the File format. The most common are JPG or DICOM, with the latter also 

containing patient information. 

6. The computer will start a guide for recording the optical disc. Follow the instructions in 

the guide until the disc is completed and ejected. 
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8. Reporting problems 

If an accident or an incident occurs when DentalEye is used, with injury to a patient or a user, or if 

a situation occurs where injury or malpractice could have occurred, DentalEye AB must be notified 

immediately in order to investigate the event and to report the incident to the authorities. 

 

The purpose of this manual is to provide a sufficient description of the product to be put to its intended 

use in a safe and efficient way. It is important that all users of the system have read the instructions for 

use and follow all safety precautions. If errors or omissions are discovered in the instructions for use, 

notify DentalEye AB! 

 

User support is primarily provided by an internal support organization or by the distributor or by 

DentalEye AB via telephone, e-mail or remote connection to solve problems. 

  

Some operations in the system can only be performed by DentalEye AB or by specially trained personnel. 

Such tasks include the following: 

 

 change the ID of a patient 

 restore an accidentally deleted image 

 database conversion or repair 

8.1. Errors in connected equipment 

A variety of equipment from other vendors can be connected to DentalEye, such as patient management 

systems, sensors and cameras. If the equipment cannot be connected or is not working properly, first 

check that it is supported by DentalEye 3.2 and that it has been properly installed according to the 

Installation instructions. Then contact the distributor who supplied or installed the equipment for 

troubleshooting. If the problem seems to be due to an error in the application, contact DentalEye AB. 

8.2. Network errors 

DentalEye must be connected to its database at all times. If the network or the server fails, a network error 

message will be displayed and no work can be performed in DentalEye until the database access is 

restored. Contact the network administrator if this occurs. 

8.3. Application errors 

If an application error occurs in DentalEye, a special error message with an error code is displayed. It is 

important to notify DentalEye AB for troubleshooting so the product can be improved. 

 

All application errors are stored in a log file on the computer where the error occurred. A report 

containing logged errors and configuration information can be submitted to DentalEye AB using the 

function System information in the Help menu of the application. 

 

 


